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SOMMAIRE EXÉCUTIF 

Le Projet 2017-01 avait pour objectif de développer une nouvelle approche visant à interpréter et 

délimiter des domaines magnétiques à partir des données de levés aéromagnétiques. Ces 

données qui sont généralement présentées sous forme d’images se prêtent bien à l’utilisation des 

techniques d’analyse d’images communes à plusieurs autres domaines (vision artificielle, imagerie 

médicale, télédétection, etc.). Une de ces techniques dites de « segmentation » permet de 

partitionner une image en rassemblant des régions aux caractéristiques similaires. Cette technique 

a été testée pour définir les domaines d’une image magnétique de levés magnétométriques. 

L’originalité de ce projet repose sur un processus de segmentation d’image magnétique qui 

s’appuie, entre autres, sur les propriétés locales de l’énergie spectrale de l’intensité du champ 

magnétique. 

La méthodologie développée se résume en trois grandes étapes : 1) discrétisation de l’image à 

l’étude en petites cellules ou fenêtres de dimension spécifique afin d’intégrer suffisamment de 

données ponctuelles (pixels) pour calculer les paramètres statistiquement valables; 2) paramétrage 

des cellules à partir d’un ensemble de propriétés du champ magnétique incluant l’énergie spectrale; 

3) classification par segmentation en domaines. 

La méthodologie a été testée principalement sur un secteur situé en majeur partie dans la portion 

ouest de la Sous-province d’Opatica et en moindre proportion dans la portion nord de la Sous-

province d’Abitibi et la partie sud de la Sous-province d’Opinaca.  

La zone d’étude a été discrétisée, en premier lieu, en cellules de 5,0 x 5,0 km (2 484 cellules 

intégrant chacune 10 0000 pixels de 50 x 50 m), puis en cellules de 2,5 x 2,5 km (9 936 cellules 

intégrant chacune 62 500 pixels de 50 x 50 m).  L’ensemble des données ponctuelles (pixels) de 

chaque cellule a servi à déterminer des paramètres caractéristiques de chaque cellule en fonction 

de : (i) de l’énergie spectrale des cellules calculée par la transformée de Fourier discrète (DFT) ou 

la transformée de Cosinus discrète (DCT), (ii) l’analyse texturale, (iii) l’analyse statistique de 

l’intensité magnétique et finalement (iv) l’analyse des crêtes magnétiques. Cette dernière analyse 

a demandé le développement d’une méthodologie particulière pour permettre de reconnaitre et de 

vectoriser les crêtes magnétiques selon un ensemble de critères spécifiques. Au total, 40 

paramètres ont été déterminés et incorporés dans la matrice de cellules. Finalement, par des 

méthodes de segmentation, c’est-à-dire de regroupement et de classification statistique (p. ex. K-

moyenne, hiérarchique, voisins proches, etc.), les cellules ont été regroupées en domaines 

magnétiques aux caractéristiques similaires. 

Les résultats obtenus montrent qu’il est possible de segmenter une image magnétique en plusieurs 

classes représentant différents domaines magnétiques. La méthode permet, entre autres, de 

reconnaitre et de cibler des ceintures de roches volcano-sédimentaires autant à l’échelle régionale 

qu’à l’échelle locale. Une autre application possible de cette méthode est la reconnaissance des 

intrusions, également à l’échelle régionale et à l’échelle locale. 
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1 INTRODUCTION 

La magnétométrie (au sol ou aérienne) est un outil essentiel à la compréhension de la géologie 

d’une région et joue un rôle prédominant en exploration minérale. L’analyse des données 

magnétométriques aide de plus en plus à sélectionner des territoires de cartographie régionale, à 

délimiter des zones prospectives et à préciser des cibles de forage plus locales (Clark, 1997). 

L’amélioration continue des techniques d’acquisition et de traitement a permis d’accroitre 

considérablement la qualité des données aéromagnétiques et de maintenir les levés à des prix 

abordables. Parmi les diverses techniques de traitement de données, celle fondée sur la 

transformée de Fourier est particulièrement efficace. Elle comprend les étapes suivantes :  

(i) Application de la transformée de Fourier pour effectuer un passage du domaine spatial 

au domaine des nombres d’onde ;  

(ii) Analyse du spectre des fréquences spatiales ; 

(iii) Rehaussement par filtrage des nombres d’onde indésirables. Différents filtres 

permettent de rehausser les images du champ magnétique : première dérivée 

verticale, première dérivée horizontale en « X », première dérivée horizontale en « Y », 

première dérivée horizontale totale, le tilt magnétique (« tilt derivative »), le signal 

analytique, la réduction aux pôles, la susceptibilité apparentes, etc.);  

(iv) Application de la transformée inverse de Fourier pour effectuer un retour au domaine 

spatial. Le résultat final est une image rehaussée des données magnétométriques. 

 

Toutefois, la méthodologie pour l’interprétation des levés magnétométriques demeure relativement 

classique. Même si la table à dessin a laissé place à l’ordinateur, les levés magnétométriques sont 

interprétés manuellement et subjectivement en fonction de l’expérience de l’utilisateur. Chaque 

entreprise de consultation ou d’exploration procède généralement plus ou moins de la même 

manière lors de l’interprétation de ces levés. 

 

Le Projet 2017-01 a pour objectif de développer une nouvelle approche visant à interpréter et 

délimiter des domaines magnétiques à partir de levés magnétométriques de haute résolution, et 

ce, de manière semi-automatique. Autrement dit, ce projet cherche à améliorer le processus 

d’analyse des données par le développement d’un algorithme d’interprétation pseudo-géologique. 

La technique d’analyse d’images par «segmentation» fondée sur la classification est l’approche 

privilégiée. Bien que cette technique dite de «segmentation» soit largement utilisée dans plusieurs 

autres domaines, elle n’a apparemment jamais été testée pour délimiter les domaines magnétiques 

sur des images obtenues des données magnétométriques aéroportées. 
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2 ZONE D’ÉTUDE 

Le secteur choisi pour l’étude se situe en majeure partie dans la portion ouest de la Sous-province 

d’Opatica et en moindre proportion dans la portion nord de la Sous-province d’Abitibi et la partie 

sud de la Sous-province d’Opinaca. La zone de 345 kilomètres de longueur par 180 kilomètres de 

hauteur, couvre une superficie de 62 121 km2 et se trouve sur les territoires du Plan Nord (Figures 

1 à 5). Elle couvre partiellement la zone délimitée dans le cadre du projet 2016-01 (Lavoie, 2017). 

La géologie du secteur est dominée par des roches métaplutoniques (TTG mésoarchéens). La 

zone comprend la majeure partie de la ceinture de roches volcano-sédimentaires de Frotet-Evans 

(en incluant les segments de Colomb-Chabouillé et de la rivière Obmasca). Les roches sont poly-

déformées et métamorphisées au faciès des amphibolites avec quelques fenêtres locales 

préservées aux faciès des schistes verts ou au faciès des granulites pour les Sous-provinces 

d’Opatica et d’Opinaca et métamorphisée au faciès des schistes verts pour la Sous-province 

d’Abitibi. On observe de grands cisaillements majeurs ± E-O surtout au contact de la ceinture de 

roches volcano-sédimentaires et des décrochements plus tardifs NO-SE / NE-SO (p. ex. zone de 

déformation de la rivière Nottaway et du ruisseau Lucky Strike). La zone couvre, en totalité ou 

partiellement, les feuillets SNRC 32/E, 32/F, 32/G, 32/J, 32/K, 32/L, 32/M, 32/N et 32/O. La liste 

des feuillets SNRC 1:50 000 touchant la zone d’étude, sont listés en Annexe 1. Les lecteurs 

peuvent se référer au Projet CONSOREM 2016-01 (Lavoie, 2017) pour une description plus 

complète du contexte géologique et métallognénique du secteur d’étude. 

 

Figure 1 : Étendue de la zone d’étude du projet 2017-01 (rectangle gris pâle) et des infrastructures présentes 

(lignes rouges et noires). 
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Figure 2 : Levés magnétométriques utilisés dans le cadre de ce projet (données provenant de SIGEOM; 

Intissar et Benahmed, 2014; D’Amours et Intissar, 2012; D’Amours, 2011). Espacement des lignes de vol = 
250 mètres; hauteur de vol = 80 à 100 mètres et direction du vol = Nord-Sud. 

 

Figure 3 : Localisation de la zone d’étude 2017-01 (cadre noir) par rapport aux limites des Sous-provinces 

géologiques (cf. SIGÉOM). 
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Figure 4 : Les différents segments de la ceinture de roches volcano-sédimentaire de Frotet-Evans (incluant 

les segments Obamsca et Colomb-Chaboullié) ainsi que la ceinture de la Sous-province d’Abitibi. Modifiée de 
Boily et Dion (2002) et du portail cartographique CONSOREM (2018). 

 

Figure 5 : Géologie de la ceinture de roches volcano-sédimentaires de Frotet-Evans en incluant les segments 

Obamsca et Colomb-Chaboullié (modifiée de Thériault et Beauséjour, 2012; Leclerc et al., 2016) et de la 

ceinture de roches volcano-sédimentaire de la partie septentrionale d’Abitibi (portail CONSOREM, 2018). 
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3 MÉTHODOLOGIE ET PRÉSENTATION DES RÉSULTATS 

3.1 Introduction 

La technique d’analyse d’images par «segmentation» fondée sur une classification non supervisée 

fut l’approche privilégiée pour discrétiser la zone d’étude en différents domaines magnétiques. La 

classification se fonde sur différents paramètres calculés au moyen de:  

(1) la caractérisation de l’énergie spectrale 
(2) l’analyse texturale de l’intensité magnétique; 
(3) la reconnaissance et la caractérisation des crêtes magnétiques;  
(4) l’analyse statistique des données. 

 

Ces paramètres sont attachés à chacune des cellules d’une matrice couvrant l’ensemble de la 

zone d’étude. Cette approche ne semble jamais avoir été testée auparavant dans la littérature 

même si l’analyse par « segmentation » fondée sur la classification est largement utilisée dans de 

nombreux domaines, tels que la vision artificielle pour les robots ou les automobiles, l’imagerie 

médicale, la télédétection, la gestion du trafic routier en temps réel, en transport, pour la 

reconnaissance d’empreintes digitales et faciales, etc. (p. ex. Fu et Mui, 1981; Pal et Pal, 1993; 

Dass et al., 2012; Mageswari et al., 2013; Dhanachandra et al., 2015). Les auteurs de ce rapport 

considèrent la méthodologie développée dans le cadre de ce projet comme un « Proof of 

concept ». Les avantages d’utiliser cette méthode sont nombreux et les deux principaux sont : 1) 

le gain d’information pour délimiter les domaines magnétiques et 2) l’élimination du biais de 

l’observateur. 

 

La figure 6 présente un organigramme de la méthodologie développée. L’organigramme se divise 

en trois principales étapes : (1) la discrétisation de la zone d’étude en « M x N » cellules 

(fenestration); (2) la caractérisation de chaque cellule par les méthodes d’analyses suivantes : (i) 

l’énergie spectrale et l’analyse texturale de l’intensité magnétique calculée par des Transformées 

de Cosinus Discrète (DCT; ex. Pun et Zhu, 2009); (ii) par l’analyse des crêtes magnétiques et (iii) 

par l’analyse statistique de l’intensité magnétique; et finalement (3) le regroupement et la 

classification statistique non supervisé. Ces trois grandes étapes mèneront à la création d’une 

carte de domaines magnétiques qui couvrira l’ensemble de la zone d’étude. Ce chapitre présente 

en détail chaque étape de cette méthodologie ainsi que les résultats obtenus. 
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Figure 6 : Organigramme de la méthodologie développée. 
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3.2  Définitions 

Avant d’entrer dans le cœur de ce chapitre, il est approprié de définir quelques notions 

fondamentales de la segmentation d’images. Selon Pal et Pal (1993), la segmentation est le 

processus par lequel on partitionne une image en plusieurs régions contiguës de telle sorte que 

chaque région est homogène et que l’union de 2 régions non contiguës est homogène. Selon 

Horowitz et Pavlidis (1974), la segmentation peut alors être définie comme suit : si F est le nombre 

de pixels totaux et P() est l’uniformité (homogénéité) prédite définie sur un groupe de pixels 

contigus, alors la segmentation est le partitionnement d’un ensemble de pixels F en un ensemble 

de sous-ensembles connectés ou régions (S1, S2, …Sn) telles que : 

6)  
 

 

L’uniformité prédite P(Si) = vraie pour toutes les régions (Si) et P(Si U Sj) = faux quand Si est 

adjacent à Sj. La qualité du résultat final dépendra largement de la qualité du processus de 

segmentation (Pal et Pal, 1993). De nombreuses techniques de segmentation d’images ont été 

développées récemment. C’est pourquoi il est très important de choisir la bonne technique pour 

obtenir le meilleur résultat. 

 

3.3 Discrétisation 

La première étape de la méthodologie développée consiste à discrétiser la carte de l’intensité du 

champ magnétique en M x N « cellules ». Dans le cadre du projet, deux dimensions distinctes de 

cellule ont été testées : (1) des cellules de 5,0 x 5,0 km (Figure 7); et (2) des cellules de 2,5 x 2,5 

km (Figure 8). Dans le premier cas, la zone d’étude a été discrétisée en 2 484 cellules dans une 

matrice de 36 lignes par 69 colonnes (Figure 7). Chaque cellule, d’une surface de 25 km2, se 

subdivise en 100 x 100 pixels de 50 x 50 mètres chacun. Dans le deuxième cas, la zone d’étude a 

été discrétisée en 9 936 cellules dans une matrice de 72 lignes par 138 colonnes (Figure 8). 

Chaque cellule, d’une surface de 6,25 km2, est subdivisée en 250 x 250 pixels de 50 x 50 mètres 

chacun. La discrétisation est facilement réalisable avec le logiciel ArcGIS®-ESRI au moyen de l’outil 

« Create Fishnet » (Figure 9 : « Data Management -> Sampling -> Create Fishnet »). Il est par 

contre très important que la classe d’entité spatiale créée ait la même projection que le fichier 

matriciel en format .GRD du levé aéroporté (généralement le géoïde WGS84 et la projection UTM). 

De plus, lors de la création de la matrice, il est impératif de créer un champ dont la variable est de 

type Entier (« Integer ») et de peupler ce champ par le chiffre «1». Cette étape est importante lors 

de l’application de la méthodologie pour la reconnaissance semi-automatique des crêtes 

magnétiques. 

Nous présenterons dans ce rapport seulement les résultats obtenus avec la discrétisation de la 

carte de l’intensité du champ magnétique de la matrice de cellules de 2,5 x 2,5 km (Test #2). 
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Figure 7 : Carte de l’intensité du champ magnétique discrétisée en 2 484 cellules de 5x5 km (Test #1). 

 

 

Figure 8 : Carte de l’intensité du champ magnétique discrétisée en 9 936 cellules de 2,5 x 2,5 km (Test #2). 
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Figure 9: Boîte de dialogue de l’outil Create Fishnet dans ArcGIS®-ESRI. 

 

3.4 Caractérisation des cellules 

Plusieurs paramètres caractéristiques des cellules (couleurs, textures, niveau de gris, etc.) peuvent 

être calculés et utilisés par les techniques de segmentation d’images. Dans le cadre de ce projet, 

quatre types de méthodes d’analyses ont servi à paramétrer chaque cellule (Annexe 2): 

(1) l’analyse spectrale calculée au moyen des Transformées de Cosinus Discrètes (DCT; ex. 
Pun et Zhu, 2009); 

(2) l’analyse texturale; 
(3) la reconnaissance semi-automatique et la caractérisation des crêtes magnétiques; 
(4) l’analyse statistique des données (c.-à-d. la moyenne, l’écart-type, minimum, maximum, 

médiane, etc.). 
 

Au total, 40 paramètres de caractérisation sont attachés à chaque cellule. Ces différents 

paramètres sont présentés en Annexe 2. 
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3.4.1 Caractérisation de l’intensité magnétique par l’énergie spectrale  

3.4.1.1 Définition de l’énergie spectrale 

Les mesures géophysiques couvrent habituellement un certain territoire donné. Selon Allard et 

Bois (1999), la représentation et l’analyse de ces mesures en fonction de leur position se font dans 

le domaine spatial (Tableau 1; Allard et Bois, 1999). Par contre, l’analyse spectrale d’un signal (p. 

ex. l’intensité magnétique) consiste à calculer la quantité d’énergie (ou de puissance) contenue 

dans les différentes composantes fréquentielles de ce signal. On pourra, par exemple, définir la 

puissance spectrale du signal (c.-à-d. l’intensité magnétique) directement à partir de différentes 

méthodes comme la transformée discrète de Fourier (DFT ou FFT) ou dans notre cas, par la 

transformée discrète en Cosinus (DCT; p. ex. Pun et Zhu, 2009). Après l’application de ces 

méthodes (DCT, FFT ou DCT), la représentation et l’analyse de ces mêmes mesures se font en 

fonction de leurs fréquences spatiales (Allard et Bois, 1999). On parlera alors du domaine des 

nombres d’onde. En d’autres termes, ces techniques d’analyse permettent de transformer des 

données à références spatiales en valeurs d’amplitude et de phase de fréquences spatiales 

(Tableau 1; Allard et Bois, 1999). L’énergie spectrale est ainsi calculée pour chaque cellule de 2.5 

x 2.5 km à partir d’un code maison élaboré avec le logiciel MATLABTM. Le code permet alors de 

calculer les paramètres de l’énergie spectrale pour chacune des cellules de la matrice (Annexe 2). 

Les spectres d’énergie de chaque cellule sont alors représentés en 2 dimensions (x,y), où une 

partie est réelle et l’autre partie est imaginaire (Figure 10 et équation 1). Comme montré à 

l’annexe 2, le code MATLABTM développé calcule 5 paramètres à partir de l’énergie spectrale (c.-

à-d. basses fréquences spatiales, fréquences spatiales intermédiaires, hautes fréquences 

spatiales, fréquences spatiales d’orientation N-S et fréquences spatiales d’orientation E-O). Les 

valeurs de coupures utilisées pour déterminer les fréquences spatiales sont : basses fréquences 

spatiales ≤1 cycle/km; fréquences spatiales intermédiaires entre 1 et 2 cycles/km et hautes 

fréquences spatiales entre 2 cycles/km et la fréquence de Nyquist (10 cycles/km). Le fichier de 

sortie des données calculées est de type ASCII. La matrice peut être alors peuplée avec ce fichier 

ASCII (transformé préalablement en fichier de type shapefile) en effectuant un joint spatial entre 

les deux tables. Il est important de mentionner que l’énergie spectrale se calcule sur des données 

ayant déjà subi un traitement d’interpolation et non sur les données brutes. 

Équation 1 : Spectre d’énergie = (Partie réelle)2 + (Partie imaginaire)2 
 
Tableau 1 : Exemples de domaines de mesure et de domaines d’analyse après transformation 

(tableau tiré et modifié de Allard et Bois, 1999). 

Phénomènes 
Domaine 

de mesure 
Fonction 
mesurée 

Fonction après 
transformation 

Domaine après 
transformation 

Enregistrement d'un 
son par un appareil 

Temporel u(t) v(f) et F(Ø) Fréquentiel 

Diffusion d'une 
musique dans une 

salle 

Spatio-
temporel 

u(x,y,z,t) 
v(kx, ky, kz, f) et 

F(Øx, Øy, Øz, Øf) 
Fréquentiel et 

nombres d'onde 

Mesures géophysiques 
le long d'un profil 

Spatial u(x) v(kx) et F(Øx) Nombres d'onde 

Mesures géophysiques 
sur un territoire 

Spatial u(x,y) v(kx, ky) et F(Øx, Øy) Nombres d'onde 
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Les avantages d’utiliser l’énergie spectrale, et non seulement la mesure de l’intensité magnétique 

pour caractériser les cellules de la matrice sont que le spectre d’énergie décrit intégralement les 

caractéristiques de l’intensité du champ magnétique de chacune des cellules, c.-à-d. l’orientation, 

la largeur ou la profondeur, l’intensité, la dimension/longueur des anomalies magnétiques (Figure 

11). Toutes les cellules étant de forme et de dimension égale, les spectres d’énergie ne contiennent 

peu ou pas d’artefact ou de variabilité liées au processus de la transformée de Fourier (DFT ou 

FFT) ou de la transformée discrète en cosinus (DCT). Ainsi, l’analyse spectrale permet de 

paramétrer l’empreinte magnétique de chaque cellule qui, ultimement, sera à la base utilisée pour 

délimiter les différents domaines magnétiques. 

 

 

Figure 10 : Représentation graphique d’un spectre d’énergie en deux (2) dimensions. Mentionnons que pour 

des fins de représentation, il y a une symétrie gauche-droite (miroir) par rapport à l’axe des y. Les couleurs 
représentent l’intensité de l’énergie spectrale. Les basses fréquences spatiales (cycles/km) sont localisées au 
centre du graphique et à l’intérieur du cercle vert (teintes mauves) tandis que les hautes fréquences spatiales 
(cycles/km) sont localisées à l’intérieur du cercle noir (teintes roses). Les structures nord-sud sont localisées 
sur l’axe des « x » (ellipses bleues), les structures E-O sur l’axe des « y » (ellipse jaune) et les structures 
N135 et N235 sont représentées par les deux ellipses grises. 
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Figure 11 : Représentation des spectres d’énergie en fonction des caractéristiques de l’intensité du champ 

magnétique (effet sur le spectre d’énergie) : i) Effet de l’intensité de l’anomalie; ii) effet de la dimension 
(épaisseur) de l’anomalie; iii) effet de l’orientation de l’anomalie et iv) effet de la longueur de l’anomalie. 

 

3.4.1.2 Présentation des résultats de la caractérisation de l’intensité magnétique par le calcul de 
l’énergie spectrale 

Cette section présente les résultats en carte du calcul de l’énergie spectrale par la méthode de la 

transformée discrète en cosinus (DCT ; e.g. Pun et Zhu, 2009). Les 5 paramètres calculés par cette 

méthode, c.-à-d. l’énergie des basses fréquences spatiales, l’énergie des fréquences spatiales 

intermédiaires, l’énergie des hautes fréquences spatiales, l’énergie des fréquences spatiales 

d’orientation N-S et l’énergie des fréquences spatiales d’orientation E-O qui sont présentées aux 

figures 12 à 16. Pour fin de visualisation sur les figures 12 à 16, les valeurs de l’intensité de 

l’énergie spectrale par cellule sont classifiées par la méthode des centiles avec un nombre de 

classes n = 10. 

Les figures 12a, 13a et 14a montrent les différentes classes définies par le calcul de l’énergie 

spectrale des fréquences spatiales. Les cellules circonscrites par les hautes énergies et 

représentées par les couleurs chaudes (autant par l’énergie calculée des basses fréquences 

spatiales, l’énergie des fréquences spatiales intermédiaires et l’énergie des hautes fréquences 

spatiales) semblent correspondre en général avec une interprétation géologique basée sur le 

SIGEOM à des ceintures de roches volcano-sédimentaires avec dominance de roches volcaniques 

mafiques/ultramafiques à intermédiaires (p. ex. segment Storm-Evans de la ceinture de Frotet-

Evans représenté à la figure 4; Boily et Dion, 2002) et/ou à des roches plutoniques felsiques plus 

ou moins gneissiques et migmatisées ainsi qu’aux différentes familles de dykes de diabase/gabbro 

du paléoprotérozoïque. Les cellules circonscrites par les énergies spectrales intermédiaires et 

représentées par les couleurs jaunes et turquoises semblent correspondre en général avec une 

interprétation géologique basée sur le SIGEOM aux intrusions mésoarchéennes de Tonalite-

Trondhjémite-Granite (TTG), foliées à gneissiques. 
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Finalement, les cellules circonscrites par les faibles énergies spectrales et représentées par les 

couleurs froides semblent correspondre en général avec une interprétation géologique basée sur 

le SIGEOM à des bassins de roches métasédimentaires, associés ou non à des ceintures de 

roches volcano-sédimentaires ou à des intrusions et/ou des orthogneiss de la suite des TTG 

mésoarchéennes (Tonalite-Trondhjémite-Granite) et possiblement migmatisées. Ceci pourrait 

s’expliquer par le paroxysme du métamorphisme de ces roches. Les roches de hautes pressions 

et les éclogites sont généralement des roches paramagnétiques. La magnétite cesse de se former 

à des pressions généralement comprises entre 10-20 kbar (Clark, 1997). 

Dans le cadre du projet CONSOREM 2016-01 (Lavoie, 2017), les domaines magnétiques et les 

dykes de diabase/gabbro paléoprotérozoïques d’une partie de la zone d’étude de ce projet ont été 

interprétés manuellement. Les figures 12b, 13b et 14b illustrent respectivement l’énergie des 

basses fréquences spatiales, l’énergie des fréquences spatiales intermédiaires et l’énergie des 

hautes fréquences spatiales avec une superposition de ces domaines magnétiques et de dykes 

paléoprotérozoïques. Généralement, une bonne correspondance peut être observée entre les 

domaines magnétiques interprétés dans le cadre du projet 2016-01 (Lavoie, 2017) et les cellules 

classifiées à partir de l’énergie spectrale dans le cadre de ce projet. De plus, les différentes familles 

de dykes de diabase/gabbro du paléoprotérozoïques peuvent également être discriminées selon 

leurs orientations avec le calcul de l’énergie spectral des fréquences spatiales d’orientation N-S et 

d’orientation E-O (Figures 15 et 16). 
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Figure 12 : A) Calcul de l’énergie spectrale des basses fréquences spatiales (≤1 cycle/km) avec une 

classification par la méthode des centiles (n = 10 classes). B) Calcul de l’énergie spectrale des basses 
fréquences spatiales (≤1 cycle/km) avec une classification par la méthode des centiles (n = 10 classes) avec 
la représentation des domaines magnétiques (lignes noires) et des dykes de diabase/gabbro 
paléoprotérozoïques (traits bruns) interprétés manuellement dans le cadre du projet 2016-01 (Lavoie, 2017). 
Remarquez la bonne correspondance générale entre les domaines magnétiques interprétés dans le cadre du 
projet 2016-01 et l’énergie spectrale des basses fréquences spatiales. 

A 

B 
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Figure 13 : A) Calcul de l’énergie spectrale des fréquences spatiales intermédiaires (1 <> 2 cycles/km) avec 

une classification par la méthode des centiles (n = 10 classes). B) Calcul de l’énergie spectrale des fréquences 
spatiales intermédiaires (1 <> 2 cycles/km) avec une classification par la méthode des centiles (n = 10 classes) 
avec la représentation des domaines magnétiques (lignes noires) et des dykes de diabase/gabbro 
paléoprotérozoïques (traits bruns) interprétés manuellement dans le cadre du projet 2016-01 (Lavoie, 2017). 
Remarquez la bonne correspondance générale entre les domaines magnétiques et certains dykes tardifs 
orientés NE-SO interprétés dans le cadre du projet 2016-01 et l’énergie spectrale des basses fréquences 
spatiales. 

A 

B 
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Figure 14 : A) Calcul de l’énergie spectrale des hautes fréquences spatiales (2 <> 10 cycles/km) avec une 

classification par la méthode des centiles (n = 10 classes). B) Calcul de l’énergie spectrale des hautes 
fréquences spatiales (2 <> 10 cycles/km) avec une classification par la méthode des centiles (n = 10 classes) 
avec la représentation des domaines magnétiques (lignes noires) et des dykes de diabase/gabbro 
paléoprotérozoïques (traits bruns) interprétés manuellement dans le cadre du projet 2016-01 (Lavoie, 2017).  
Remarquez la bonne correspondance générale entre les domaines magnétiques et la majorité des dykes 
tardifs orientés NE-SO et certains dykes N-S et NO-SE interprétés dans le cadre du projet 2016-01 et l’énergie 
spectrale des basses fréquences spatiales. 

A 

B 
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Figure 15 : Calcul de l’énergie spectrale des fréquences spatiales orientées nord-sud avec une classification 

par la méthode des centiles (n = 10 classes). Remarquez les domaines magnétiques nord-sud représentés 
par les anomalies magnétiques causées par les dykes paléoprotérozoïques orientés nord-sud. 

 

Figure 16 : Calcul de l’énergie spectrale des fréquences spatiales orientées est-ouest avec une classification 

par la méthode des centiles (n = 10 classes).  Les domaines magnétiques nord-sud représentés par les 
anomalies magnétiques causées par les dykes paléoprotérozoïques orientés nord-sud et bien visibles sur la 
figure 15, ne sont plus circonscrits sur cette figure. 
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3.4.2 Analyse texturale  

L’analyse texturale est souvent utilisée en segmentation d’images. Pour les paramètres texturaux 

(Annexe 2), une égalisation d'histogramme est appliquée sur l’image initiale pour obtenir une 

image à 64 niveaux d’intensité de gris. L'analyse texturale est produite sur les valeurs d'intensité 

résultantes. En pratique, les valeurs d'intensité sont d’abord rééquilibrées entre 0 et 1 (re-normalisé 

par la valeur maximale d'intensité dans l'image). Cette étape permet à l'égalisation de 

l'histogramme de mieux fonctionner lors des calculs. Mais ce qu'il faut comprendre dans l’analyse 

texturale, c'est que cette méthode se fait directement sur l’intensité magnétique de chaque cellule. 

Le nombre de cellules est le même que pour le calcul de l’énergie spectrale (n = 9 936). 

Dans le cadre de cette phase du projet, les données calculées de l’analyse texturale n’ont pu faire 

l’objet de vérification. Les auteurs recommandent fortement de continuer les tests avec ces 

nombreuses données disponibles. Pour les besoins du rapport, seulement un exemple d’un 

coefficient calculé est présenté à la figure 17 (ex. GLCM_Contrast).  Pour une meilleure 

visualisation des données, une classification par la méthode des bris naturels (Jenks) avec n = 10 

classes ont été utilisées pour cette figure. 

 

Figure 17 : Calcul du coefficient GLCM_Contrast au moyen de caractérisation par l’analyse texturale 

(classification par la méthode des bris naturels, Jenks, n = 10 classes). Les cellules représentées par les 
segments de roches volcano-sédimentaires de Storm-Evans, Evans-Ouagama et Rivière Obamsca et les 
roches volcaniques mafiques de la Sous-province d’Abitibi (Figure 4; Boily et Dion, 2002) ainsi que différentes 
familles de dykes tardifs paléoprotérozoïques sont bien délimités par ce coefficient. 
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3.4.3 Analyse statistique de l’intensité magnétique  

3.4.3.1 Méthodologie 

Dans la conception du code MATLABTM utilisé pour le calcul de l’énergie spectacle et de l’analyse 

texturale, des lignes de codes ont été insérées pour calculer les statistiques classiques de 

l’intensité magnétique (c.-à-d. le compte de pixel, les valeurs minimales et maximales, la somme, 

la moyenne, l’écart-type et la gamme de l’intensité magnétique) et ce, sur chaque cellule (Annexe 

2, volet 2). Ces paramètres peuvent également être calculés avec le logiciel ArcGIS®-ESRI avec 

l’outil « Zonal Statistic as Table » dans l’outil de calcul « Spatial Analyst » (Figure 18). Cette 

opération ne peut être effectuée que sur une couche matricielle de l’intensité magnétique 

(« Raster »). Le fichier de sortie des données calculées est de type ASCII.  La matrice peut être 

alors peuplée avec ce fichier ASCII en effectuant un joint spatial entre les deux tables. Il est 

important de mentionner que l’analyse statistique de l’intensité magnétique est effectuée sur des 

données ayant déjà subi un traitement d’interpolation et non sur les données brutes. 

 

Figure 18: Boîte de dialogue de l’outil Zonal Statistics as Table dans ArcGIS®-ESRI. 

  



 
_____________________________________________________________________________
  

_____________________________________________________________________________ 
20 

 

3.4.3.2 Présentation des résultats de l’analyse statistique  

Seuls les résultats de la caractérisation de l’intensité magnétique calculée par la moyenne (Figure 

19) et l’écart-type (Figure 20) seront présentés dans cette section. Ces deux paramètres ont été 

utilisés pour les tests effectués lors de la segmentation et le regroupement des domaines 

magnétiques. 

 

Figure 19 : Caractérisation de l’intensité magnétique calculée par la moyenne de chaque cellule avec une 

classification par la méthode des centiles (n = 10 classes). 

 

Figure 20 : Caractérisation de l’intensité magnétique calculée par l’écart-type de chaque cellule avec une 

classification par la méthode des centiles (n = 10 classes). 
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3.4.4 Reconnaissance semi-automatique et analyse des crêtes magnétiques 

3.4.4.1 Définition 

Une crête magnétique est représentée par une anomalie linéaire positive de plus forte intensité 

que son environnement immédiat. Cette crête magnétique est accompagnée de deux creux 

magnétiques localisés de part et d’autre de celle-ci (Figure 21). L’interprétation des crêtes 

magnétiques est importante lors de l’interprétation des domaines magnétiques. Les domaines 

magnétiques peuvent être interprétés au moyen du contraste magnétique entre deux domaines 

(interprétation manuelle; p. ex. projet 2016-01; Lavoie, 2017) ou au moyen de l’énergie spectrale, 

de l’analyse texturale et de l’analyse statistique de l’intensité magnétique (présent rapport). Un 

paramètre vient souvent appuyer l’interprétation des domaines magnétiques : la caractérisation du 

rubanement magnétique (crête magnétique) observé dans chaque domaine magnétique (Figure 

22; projet 2016-01).  Selon Chardon et al. (2008), l’analyse géométrique du motif structural des 

fabriques tectoniques (c.-à-d. crête magnétique) peut se faire par : 1) la forme des trajectoires; 2) 

la déflexion (orientation); 3) le regroupement (densité) et 4) la linéarité. Dans le cadre de ce projet, 

un volet s’est attaqué au développement d’une méthodologie de reconnaissance semi-automatique 

des crêtes magnétiques pour définir deux des quatre paramètres mentionnés ci-haut, soit 

l’orientation et la densité. Le développement de cette méthodologie permet d’éliminer le biais 

d’interprétation engendré par l’interprétation manuelle des crêtes magnétiques. Cette interprétation 

sera variable en fonction de l’observateur, de la limite de l’œil humain, des traitements 

géophysiques effectués sur le levé aéromagnétique (filtre), par des paramètres externes, etc. La 

méthodologie est présentée à la section 3.4.4.2. 

 

 

Figure 21 : Représentation d’une crête magnétique avec deux creux magnétiques de part et d’autre de cette 

dernière. 
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Figure 22 : Interprétation manuelle des crêtes magnétiques (lignes simples bleues) effectuée sur la zone 

d’étude 2016-01 (lignes grasses bleues) dans le cadre du projet CONSOREM 2016-01 (Lavoie, 2017). 

 

3.4.4.2 Méthodologie pour la reconnaissance semi-automatique des crêtes magnétiques 

La méthodologie développée pour la reconnaissance semi-automatique des crêtes magnétiques 

dans le cadre de ce projet se veut simple et peut être effectuée en quelques étapes seulement 

(Figure 23). Comme mentionné précédemment, la méthodologie élimine les biais de l’observateur 

et augmente l’efficacité lors de l’interprétation structurale des levés magnétométriques. Par contre, 

elle nécessite les logiciels GeosoftTM et ArcGIS®-ESRI. À l’image de la classe d’entité créée à la 

section 3.3 (matrice), il est très important de s’assurer que la classe d’entité créée pour les crêtes 

magnétiques (classe d’entités vectorielles) ait la même projection que le fichier matriciel format 

.GRD du levé aéroporté (généralement le géoïde WGS84 et la projection UTM). 
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Figure 23 : Figure synthèse de la méthodologie développée pour la reconnaissance semi-automatique des 

crêtes magnétiques à partir d’un levé magnétométrique. A) Création de points anomaliques (x,y) avec le 
logiciel GeosoftTM. B) Création d’une couche matricielle à partir des points anomaliques (x,y) en A à l’aide du 
logiciel ArcGIS®-ESRI. C) Création d’une classe d’entité vectorielle à partir de la couche matricielle en B à 
l’aide du logiciel ArcGIS®-ESRI. D) Filtrage du bruit de fond pour avoir le rubanement magnétique « résiduel » 
à l’aide du logiciel ArcGIS®-ESRI. 

Les paragraphes suivants présentent les principales étapes de la méthodologie. 

Étape 1 

La première étape est effectuée avec le logiciel GeosoftTM. Il s’agit de calculer spatialement des 

points anomaliques (x,y) à partir du fichier matriciel en format .GRD GeosoftTM avec la fonction Grid 

Peaks (Figure 24; « Grid and Image -> Utilities -> Grid Peaks »). Cet outil permet de détecter et 

de trouver des anomalies magnétiques par la méthode de Blakely (Blakely et Simpson, 1986) dans 

un fichier matriciel en format .GRD GeosoftTM. Pour chaque cellule considérée, l’outil compare une 

valeur avec huit valeurs de voisins naturels dans quatre directions (selon les colonnes, les rangées 

et les 2 diagonales). L’outil permet de détecter les anomalies avec quatre niveaux de sensibilité 

(Tableau 2). Pour détecter et trouver une faible quantité d’anomalies, il faut utiliser le niveau de 

sensibilité normal (4) qui est le niveau par défaut. Par contre, pour détecter et trouver toutes les 

crêtes magnétiques, il faut utiliser le niveau de sensibilité 1 « All ridge peaks ». Pour le projet en 

cours, les anomalies ont été détectées avec le niveau de sensibilité 2 et qui se nomme « Even 

more peaks » dans l’outil (Tableau 2) et qui donnait un bon équilibre entre un nombre trop faible 

de points anomaliques et un nombre trop élevé de points anomaliques (trop de bruit de fond). 

Aucune valeur de coupure n’a été utilisée (option « Grid value cutoff level ») et l’option « No. of 

passes of smoothing filter » a été laissée à 0 (valeur par défaut). La figure 25 montre un exemple 

de résultat des anomalies calculées par la méthode de Blakely (Blakely et Simpson, 1986) sur un 

secteur de la zone d’étude 2017-01. 
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Figure 24 : A) Boîte de dialogue de l’outil Grid Peaks (Grid and Image -> Utilities -> Grid Peaks) du logiciel 

GeosoftTM. B) Fichier de sortie dans le logiciel GeosoftTM. 

 

Tableau 2 – Quatre niveaux de sensibilité pour le calcul des anomalies par la méthode de Blakely 

(Blakely et Simpson, 1986) avec l’outil Grid Peaks du logiciel GeosoftTM.  Source : GeosoftTM. 

Niveau de sensibilité Description 

Normal (4) Grid values in all nearest grid cells are 
lower. 

More peaks (3) Grid values in any three directions are 
lower. 

Even more peaks (2) Grid values in any two directions are lower. 

All ridge peaks (1) Grid values in one direction are lower 

 

A B 
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Figure 25 : Exemple de points anomaliques détectés par la méthode de Blakely (Blakely et Simpson, 1986) 

avec l’outil Grid Peaks èa partir du logiciel GeosoftTM dans le secteur du segment Storm-Evans (Boily et Dion, 
2002) de la ceinture de roches volcano-sédimentaires de Frotet-Evans. 

Étape 2 

Une fois les points anomaliques détectés par la méthode de Blakely (Blakely et Simpson, 1986), 

la deuxième étape est de les importer du format GEOSOFT (Figure 24b) au format ASCII (p. ex. 

fichier Excel) pour pouvoir ultimement l’importer dans le logiciel ArcGIS®-ESRI dans une classe 

d’entité spatiale vectorielle (Shapefile ou Géodatabase). Une fois les points anomaliques importés 

dans ArcGIS®-ESRI, un champ dont la variable est de type Entier (Integer) doit être créé dans cette 

classe d’entité. Par la suite, ce champ doit être peuplé par le chiffre «1 » dans chaque ligne. Cette 

manipulation est importante lors de la création de la couche matricielle qui sera effectuée à la 

prochaine étape. 

Étape 3 

La troisième étape consiste à créer une couche matricielle à partir de la classe d’entité spatiale 

vectorielle de l’étape 2. Cette étape est effectuée avec le logiciel ArcGIS®-ESRI avec l’outil « Point 

to Raster » (Figure 26 : « Conversion Tools -> To Raster -> Point to Raster ») qui permet de 

convertir un ensemble de points (x, y) en une couche matricielle. Lors de la création de la couche 

matricielle, il est très important de sélectionner le champ de type Entier (Integer) créé à l’étape 2 

dans l’option « Value Field ». La couche matricielle peut être créée avec plusieurs grosseurs de 

recherche de cellule (Figure 26 ; option Cellsize).  Dans le cadre de ce projet, six (6) grosseurs de 

recherche de cellule (Cellsize) ont été testées soit : i) 50 mètres, ii) 75 mètres, iii) 100 mètres, iv) 

125 mètres, v) 150 mètres et finalement, vi) 200 mètres. Si la grosseur de recherche de cellule est 

trop petite, les pixels créés à partir des points anomaliques ne se toucheront pas. Dans ce cas, la 

couche matricielle ne sera pas représentative du rubanement magnétique réel du socle rocheux. 
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De la même manière, si la grosseur de recherche de cellule est trop grande, les pixels créés à 

partir des points anomaliques génèreront trop d’artefacts. Ces artefacts ne représenteront 

aucunement le rubanement magnétique réel du socle rocheux. Il faut alors trouver un juste équilibre 

entre les deux pour avoir la meilleure représentation possible du rubanement magnétique réel du 

socle rocheux et représenté par les crêtes magnétiques. Il va s’en dire que cette étape est cruciale 

pour obtenir un résultat qui se rapproche le plus possible de la réalité terrain en termes de 

rubanement magnétique. La moyenne par cellule qui sera calculée de la déflexion (orientation) et 

du regroupement (densité) dépendra directement du choix qui sera effectué à cette étape. Pour le 

projet en cours, les grosseurs de recherche de cellule (Cellsize) de 50 mètres et de 75 mètres 

furent éliminées, car les vecteurs générés sont généralement trop courts. Les grosseurs de 

recherche de cellule (Cellsize) de 150 mètres et de 200 mètres furent également éliminées, car il 

y avait trop d’artefacts générés par la transformation de la couche matricielle à la classe d’entité 

spatiale vectorielle (étape suivante). Les couches matricielles générées par les grosseurs de 

recherche de cellule (Cellsize) de 100 mètres et de 125 mètres semblent représenter avec le plus 

d’exactitude le rubanement magnétique réel du socle rocheux. Pour la suite du rapport, seulement 

les résultats générés par les grosseurs de recherche de cellule (Cellsize) de 125 mètres seront 

présentés (Figure 27). 

Les auteurs croient par contre que le résultat pourrait différer d’un levé magnétométrique à l’autre 

selon le secteur étudié. Il se peut que sur un secteur donné, une couche matricielle générée par 

une grosseur de recherche de cellule (Cellsize) de 75 mètres donne des résultats de meilleure 

qualité sur le rubanement magnétique réel qu’une couche matricielle générée par une grosseur de 

recherche de cellule (Cellsize) de 125 mètres. Il est alors important de faire les tests appropriés 

sur chaque terrain et de comparer avec les informations disponibles dans les bases de données. 

 

 

Figure 26: Boîte de dialogue de l’outil « Point to Raster » dans ArcGIS®-ESRI. 
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Figure 27 : Exemple de couche matricielle générée avec une grosseur de recherche de cellule (Cellsize) de 

125 mètres dans le secteur du segment Storm-Evans (Boily et Dion, 2002) de la ceinture de roches volcano-
sédimentaires de Frotet-Evans (même localisation que la figure 25). 

 

Étape 4 

La quatrième étape consiste à transformer la couche matricielle en une classe d’entité spatiale 

vectorielle. Cette étape est effectuée avec le logiciel ArcGIS®-ESRI avec l’outil « Raster to 

Polyline » (Figure 28 : « Conversion Tools -> From Raster -> Raster to Polylin »). Lors de la 

création de classe d’entité spatiale vectorielle représentant les crêtes magnétiques, il est important 

de sélectionner le champ de type Entier (Integer) créé à l’étape 2 dans l’option « Value Field » 

(Figure 28). À cette étape, il est nécessaire d’ajouter quelques champs dans notre classe d’entité 

spatiale vectorielle. Les champs qui doivent être ajoutés sont : 1) Longueur (m), 2) Orientation (o) 

et 3) Densité. La densité du rubanement magnétique sera calculée par le compte de pixel contenu 

dans chaque cellule une fois le bruit de fond du rubanement magnétique éliminé (étape suivante). 

La figure 29 montre le résultat dans le secteur du segment de Storm-Evans (Boily et Dion, 2002) 

de la ceinture de roches volcano-sédimentaires de Frotet-Evans à partir de la couche matricielle 

générée avec une grosseur de recherche de cellule (Cellsize) de 125 mètres. Sur cette figure, les 

vecteurs ont subi un traitement avec l’outil « Smooth Line » (« Cartography -> Smooth Line ») qui 

permet d’atténuer les vecteurs. Deux méthodes d’atténuation (algorithmes) sont disponibles avec 

le logiciel ArcGIS®-ESRI (Figure 30): 1) la méthode « PEAK » (acronyme pour « Polynomial 

Approximation with Exponential Kernel ») et 2) la méthode d’interpolation de Bézier. Pour l’étude 

en cours, la méthode « PEAK » a été utilisée avec une tolérance (Smoothing Tolerance) de 500 

mètres. 
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Figure 28: Boîte de dialogue de l’outil « Raster to Polyline » dans ArcGIS®-ESRI. 

 

Figure 29 : Exemple de la classe d’entité spatiale vectorielle générée à partir de la couche matricielle de 
l’étape 3 (Cellsize de 125 mètres) dans le secteur du segment Storm-Evans (Boily et Dion, 2002) de la ceinture 
de roches volcano-sédimentaires de Frotet-Evans (même localisation que la figure 25). Les vecteurs ont subi 
un lissage par la technique PEAK (voir texte pour les explications). 
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Figure 30: Algorithme d’atténuation des vecteurs disponible dans ArcGIS®-ESRI : 1) 1) par la méthode PEAK 

(acronyme pour Polynomial Approximation with Exponential Kernel) et 2) par la méthode d’interpolation 

de Bézier.  Dans notre cas, la méthode PEAK a été utilisée.  Source : ArcGIS®-ESRI. 

 

Étape 5 

La cinquième étape consiste à éliminer les vecteurs représentant le « bruit de fond » du 

rubanement magnétique. Le but de cette étape est de représenter le rubanement magnétique 

régional et d’éliminer au maximum les effets des discontinuités magnétiques tardives. Pour éliminer 

ce « bruit de fond » magnétique, plusieurs tests ont été effectués : éliminer les vecteurs de moins 

de 100 m, de 150 m, de 200 m, de 300 m, de 400 m, de 500 m, de 600 m, de 700 m, de 800 m, et 

finalement de 1000 m. Dans notre cas, pour obtenir une représentation juste et fidèle du 

rubanement magnétique du socle rocheux, éliminer les vecteurs d’une longueur de 2 fois l’écart-

type (en éliminant les vecteurs plus petits que 752 m) semblait représenter un résultat plausible 

(Figure 31). La figure 32 montre la comparaison entre l’interprétation manuelle des crêtes 

magnétiques dans le cadre du projet CONSOREM 2016-01 (Lavoie, 2017) et la reconnaissance 

semi-automatique des crêtes magnétiques dans le cadre de ce projet. Généralement, il y a une 

bonne correspondance entre les deux résultats. Certains secteurs ont plus d’informations avec une 

méthode et inversement. La figure 33 montre le résultat final de la reconnaissance semi-

automatique des crêtes magnétiques sur le secteur d’étude 2017-01. 

Encore une fois, les auteurs croient que le résultat pourrait différer d’un levé magnétométrique à 

l’autre selon le secteur étudié. Il se peut que sur un secteur donné, éliminer les vecteurs plus petits 

que 2 fois l’écart-type s’avère n’être aucunement représentatif de la réalité terrain en termes de 

rubanement magnétique. C’est pourquoi il est important de faire les tests appropriés sur chaque 

terrain et de comparer avec les informations disponibles dans les bases de données. 
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Figure 31 : Exemple de la classe d’entité spatiale vectorielle sans « bruit de fond » dans le secteur du 

segment Storm-Evans (Boily et Dion, 2002) de la ceinture de roches volcano-sédimentaires de Frotet-Evans 
(même localisation que la figure 25). Les vecteurs de moins de 752 mètres (plus petits que 2 fois l’écart-type) 
ont été éliminés. Cette figure représente le rubanement magnétique utilisé pour calculer l’orientation moyenne 
et la densité moyenne pour chaque cellule de la matrice. 

 

Figure 32 : Comparaison entre A) l’interprétation manuelle des crêtes magnétiques effectuées dans le cadre 

du projet CONSOREM 2016-01 (Lavoie, 2017) et B) la reconnaissance semi-automatique des crêtes 
magnétiques dans le secteur du segment Storm-Evans (Boily et Dion, 2002) de la ceinture de roches volcano-
sédimentaires de Frotet-Evans (même localisation que la figure 25) dans le cadre du projet CONSOREM 
2017-01. 

 

A B 
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Figure 33 : Résultat de la reconnaissance semi-automatique des vecteurs représentant les crêtes 

magnétiques sur le secteur d’étude (Cellsize de 125 mètres et les vecteurs plus grands que 752 mètres). 
Remarquez les traces bien visibles des zones de déformation en décrochement dextre de la rivière Nottaway 
et du ruisseau Lucky Strike (ovales rouges). Le segment Storm-Evans (Boily et Dion, 2002) de la ceinture de 
roches volcano-sédimentaires de Frotet-Evans ressort également très bien. 

Étape 6 

La sixième et dernière étape consiste à calculer l’orientation moyenne (ainsi que l’écart-type 

associé) des vecteurs représentant le rubanement magnétique ainsi que la densité moyenne du 

rubanement magnétique pour chaque cellule de la matrice. Pour le calcul de l’orientation de chaque 

vecteur, les auteurs ont utilisé le logiciel MapInfo® à l’aide de l’outil « Line Orientation » disponible 

dans Discover (« Discover -> Data Utilities -> Line Orientation »). Cette étape nécessite d’exporter 

la classe d’entité dans le logiciel MapInfo®, d’effectuer le calcul de l’orientation des vecteurs et 

d’importer de nouveau la table du format MapInfo (.TAB) en format Shapefile (.SHP). Une fois cette 

petite manipulation effectuée, une nouvelle couche matricielle sera générée à partir de la couche 

vectorielle finale (Figure 33) avec l’outil « Polyline To Raster » (Figure 34 : « Conversion Tools" -

> To Raster -> Polyline To Raster »). Lors de la création de cette couche matricielle, il est très 

important d’utiliser la valeur de l’orientation des vecteurs calculée avec le logiciel MapInfo® dans 

l’option « Value Field » et de mettre la même dimension de recherche de cellule (Cellsize) utilisée 

à l’étape 3 (c.-à-d. 125 mètres dans notre cas). Avec cette manipulation, chaque pixel aura la valeur 

de l’orientation provenant du vecteur correspondant.  

Par la suite, avec l’outil Zonal « Statistic as Table » dans le logiciel ArcGIS®- ESRI (Figure 18 ; 

dans l’outil de calcul « Spatial Analyst »), il sera possible de calculer les statistiques classiques 

sur-le-champ « Orientation » dans chaque cellule en utilisant le champ « Orientation » des 

https://www.pitneybowes.com/us/location-intelligence/geographic-information-systems/mapinfo-pro.html
https://www.pitneybowes.com/us/location-intelligence/geographic-information-systems/mapinfo-pro.html
https://www.pitneybowes.com/us/location-intelligence/geographic-information-systems/mapinfo-pro.html
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vecteurs calculé avec le logiciel MapInfo® dans l’option « Value Field » (Figure 18). Ainsi, la 

moyenne (MEAN), la médiane (MEDIAN) et l’écart-type (STD) de la variable orientation des 

vecteurs seront calculées pour chaque cellule et également la densité du rubanement magnétique, 

qui elle sera donnée par le compte de pixel dans chaque cellule (SUM). Naturellement, certaines 

cellules auront des valeurs « Null » puisque le rubanement magnétique ne sera pas 

nécessairement présent dans toutes les cellules. Les figures 35, 36 et 37 illustrent les résultats 

de l’orientation moyenne, de l’écart-type et de la densité moyenne par cellule sur la zone d’étude. 

 

Figure 34: Boîte de dialogue de l’outil « Polyline To Raster » dans ArcGIS®-ESRI. Il est très important d’utiliser 
la même dimension de recherche de cellule (Cellsize) utilisée à l’étape 3 (c.-à-d. 125 mètres dans notre cas). 

 

Figure 35: Orientation moyenne des crêtes magnétiques pour chaque cellule sur la zone d’étude. Plus les 

couleurs tendent vers le noir, plus l’orientation tend vers 00 ou vers 1800. Les zones en blancs correspondent 
avec des cellules avec absence de rubanement magnétique (Null). Classification par intervalle régulier, n = 
10 classes. 

https://www.pitneybowes.com/us/location-intelligence/geographic-information-systems/mapinfo-pro.html
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Figure 36: Variabilité (écart-type) de l’orientation moyenne des crêtes magnétiques pour chaque cellule sur 

la zone d’étude. Les couleurs froides représentent de faibles variabilités tandis que les couleurs chaudes 
représentent de fortes variabilités. Classification par la méthode des centiles, n = 10 classes. 

 

Figure 37: Densité moyenne des crêtes magnétiques pour chaque cellule sur la zone d’étude. Les couleurs 

froides représentent de faibles densités tandis que les couleurs chaudes représentent de fortes densités. La 
densité moyenne a été calculée à partir du compte de pixel (SUM) de la couche matricielle générée avec la 
classe d’entité spatiale vectorielle des crêtes magnétiques (Cellsize de 125 mètres et les vecteurs plus grands 
que 752 mètres). Classification par la méthode des centiles, n = 10 classes. 
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3.4.4.3 Synthèse 

Avec la méthodologie développée en quelques étapes (Figure 23), il est maintenant possible de 

reconnaître et de vectoriser, et ce, de manière semi-automatique, les crêtes magnétiques à partir 

d’un levé magnétométrique. La méthodologie se veut simple et amène un gain substantiel 

d’efficacité lors de l’interprétation structurale des levés magnétométriques. De plus, elle élimine le 

biais de l’observateur contrairement à l’interprétation manuelle des crêtes magnétiques. Cette 

méthodologie, nouvelle et innovatrice, pourrait être utilisée facilement par les firmes de consultants 

et les compagnies pour les études structurales effectuées à partir de n’importe lequel levé 

magnétométrique. Par contre, elle nécessite un logiciel de traitement des données géophysiques 

(p. ex. GeosoftTM) et un logiciel à géoréférence spatiale (p. ex. ArcGIS®-ESRI). 
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3.5 Regroupement et classification (Clustering) 

3.5.1 Introduction 

Cette étape est de loin la plus critique dans le processus développé. C’est ici que les cellules 

contiguës, rassemblant des caractéristiques communes, seront fusionnées pour former des 

domaines magnétiques uniformes et cohérents. Il existe des centaines de techniques de 

regroupement et de classification. Dans le cadre de ce projet, il nous a été impossible d’en tester 

plusieurs. Nous avons sélectionné deux algorithmes de regroupement et de classification qui était 

offerte dans le logiciel statistique JMP® version 8.0.2 (onglet « Analyze -> Multivariate Methods -> 

Cluster »). Les deux algorithmes de regroupement et de classification testés sont: 1) les K-

moyennes et 2) la méthode hiérarchique. Les prochains paragraphes présentent quelques 

résultats de regroupement et de classification effectués à partir de ces deux algorithmes. 

 

3.5.2 Regroupement et classification par les algorithmes de type K-Moyennes 

3.5.2.1 Définition 

Le partitionnement en  K-moyennes (K-means ) est une méthode de partitionnement de données 

basé sur la distance et un problème d'optimisation combinatoire. Étant donnés des points et un 

entier « K », le problème est de diviser les points en K-groupes (clusters) de façon à minimiser une 

certaine fonction. Cet algorithme doit généralement être utilisé avec de grosses bases de données 

(jusqu’à 100 000 observations). Pour les petites bases de données, les résultats risquent d’être 

plus sensibles et variables. 

 

3.5.2.2 Méthodologie 

Plusieurs tests ont été effectués avec la méthode de regroupement et de classification par les 

algorithmes K-Moyennes. Premièrement, il faut déterminer le nombre de paramètres qui seront 

utilisés pour le regroupement et la classification. Dans le cadre de ce projet, aucune analyse en 

composante principale (ACP) n’a été effectuée pour vérifier les paramètres corrélables entre eux. 

Des tests aléatoires ont alors été effectués sur le nombre de paramètres utilisés lors des différents 

tests. Deuxièmement, il faut choisir entre trois (3) options disponibles dans le logiciel JMP® (Figure 

38): 1) « K-Means Clustering », 2) « Normal Mixture » et 3) « Self-Organizing Map ». Seulement la 

première option a été testée ici. Et finalement, un nombre de classes (clusters) doit être défini pour 

chaque test (Figure 38). Pour ce projet, les tests ont été effectués soit avec 8 classes, ou soit avec 

10 classes. 

https://fr.wikipedia.org/wiki/Partitionnement_de_donn%C3%A9es
https://fr.wikipedia.org/wiki/Optimisation_combinatoire
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Figure 38: Boîte de dialogue de l’outil « Clustering » (Regroupement-Classification) du logiciel JMP® avec 
l’option « K-Means » sélectionnée. 

 

3.5.2.3 Présentation des résultats par le regroupement/classification des algorithmes K-Moyennes 

La figure 39 montre un résultat effectué avec un regroupement par les  K-Moyennes  avec l’option 

1 (K-Means Clustering), en utilisant 13 paramètres (Tableau 3) et un nombre de classes égal à 8 

(N = 8). Les domaines magnétiques délimités par ce test sont très bien circonscrits (p. ex. pluton 

granitique à biotite-magnétite de Nottaway localisée dans la zone de déformation de la rivière 

Nottaway ; Figure 39). Ces masses plutoniques interprétées dans le SIGEOM correspondent avec 

la classe 0 à la figure 39 (domaines en rouges). De plus, le segment de roches volcano-

sédimentaires de Storm-Evans (Boily et Dion, 2002) ainsi qu’une portion de la ceinture de roches 

volcano-sédimentaires de la Sous-province d’Abitibi (secteur Chibougamau) ressortent également 

très bien (Figure 39). La grande variété de domaines dans ces segments peut s’expliquer par une 

grande variété de lithologies comprises dans ces segments de roches volcano-sédimentaires 

(roches volcaniques ultramafiques à felsiques, formations de fer, gabbro fortement magnétique, 

intrusions diverses, roches méta-sédimentaires, etc.). Par exemple, la classe 2 est délimitée par 

une dizaine de cellules qui reviennent systématiquement dans les différents tests effectués 

(domaines en bruns foncés ; Figure 40). Ces cellules correspondent, selon la géologie interprétée 

provenant de la base de données de SIGEOM, à des unités stratiformes de formations de fer 

oxydées riches en magnétite, interlitées en quantité variable avec des tufs felsiques ou des 

basaltes appartenant à la Formation de Rabbit. 
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Figure 39: Résultat d’un regroupement/classification obtenu avec le logiciel JMP® par les algorithmes des K-
Moyennes en utilisant l’option 1 (K-Means Clustering), 14 paramètres et 8 classes (test #14b).  Remarquez 
que les différents domaines magnétiques sont bien délimités par cette méthode de 
regroupement/classification. 

 

Figure 40: Unités stratiformes de formations de fer oxydées riches en magnétite, appartenant à la Formation 

de Rabbit (polygones rouges) interprétée dans le segment Storm-Evans (Boily et Dion, 2002) et bien 
circonscrites par la classe 2 (encadrés noirs). Source géologie : SIGÉOM. 
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Tableau 3 – Liste des paramètres utilisés pour le test 14b. 
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3.5.3 Regroupement et classification par les algorithmes de type hiérarchiques 

3.5.3.1 Définition 

Les algorithmes de regroupement hiérarchiques peuvent s’expliquer ainsi : à partir d'un 

ensemble Ω de "n" individu, l’algorithme répartira ces individus dans un certain nombre de classes. 

L’algorithme commence avec chacun des points analysés dans sa propre classe (cluster). À 

chaque étape d’itération, les deux classes qui sont les plus près des uns des autres sont combinés 

dans une seule et même classe. Le processus itératif continu jusqu’à ce qu’il y ait seulement une 

classe qui comprend tous les points d’analyse. Ce processus est généralement bon pour les petites 

bases de données (quelques centaines d’observations). 

 

3.5.3.2 Méthodologie 

Plusieurs tests ont été effectués avec la méthode de regroupement et de classification par les 

algorithmes hiérarchiques. Comme pour la section précédente (K-MNoyennes), il faut déterminer 

le nombre de paramètres qui seront utilisés pour le regroupement et la classification. Comme 

mentionné précédemment, aucune analyse en composante principale (ACP) n’a été effectuée pour 

vérifier les paramètres corrélables entre eux. Des tests aléatoires ont alors été effectués sur le 

nombre de paramètres utilisés lors des différents tests. Deuxièmement, il faut choisir entre trois (3) 

options disponibles dans le logiciel JMP® (Figure 41): 1) « Average », 2) « Centroid », 3) 

« Ward », 4) « Single », 5) « Complete" » et finalement 6) « Fast Ward ». Seulement l’option 3 

(Ward) a été testée dans le cadre de ce projet. Le logiciel construit un dendrogramme comme 

illustré à la figure 42. Un dendrogramme est une représentation graphique d'une classification 

ascendante hiérarchique; il se présente souvent comme un « arbre binaire » dont les feuilles sont 

les individus alignés sur l'axe des abscisses ou des ordonnées (Figure 42). Et finalement, un 

nombre de classes (clusters) doit être défini pour chaque test (Figure 42). Pour déterminer le 

https://fr.wikipedia.org/wiki/Arbre_binaire
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nombre de classes, le dendrogramme doit être préalablement calculé et par la suite on peut choisir 

le nombre de classes en cliquant sur la petite flèche rouge en haut à gauche de la boîte de dialogue 

indiquez par la flèche rouge à la figure 42. Les tests ont été effectués soit avec 8 ou soit 10 classes.  

 

Figure 41: Boîte de dialogue de l’outil « Clustering » (Regroupement-Classification) du logiciel JMP® avec la 
méthode « Hierarchical » sélectionnée. Les six (6) options disponibles sont montrées par le rectangle rouge 

inférieur.  

 

Figure 42: Exemple de dendrogramme calculé par le logiciel JMP® avec la méthode « Hierarchical » (« option 
Ward »). Les couleurs représentent les différentes classes (N = 8 classes dans cet exemple). 
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3.5.3.3 Présentation des résultats par le regroupement/classification des algorithmes 
hiérarchiques 

La figure 43 montre un résultat effectué avec un regroupement par les algorithmes hiérarchiques 

avec l’option 3 (Ward), en utilisant 4 paramètres (Basses_Fréquences, Moyennes_fréquences, 

Hautes_Fréquences, Moyenne_nT) et un nombre de classes égal à 8 (N = 8). Les domaines 

magnétiques délimités par ce test sont également très bien circonscrits (p. ex. pluton granitique à 

biotite-magnétite de Nottaway localisé dans la zone de déformation de la rivière Nottaway, pluton 

dioritique d'Hugh au nord du segment Storm-Evans; Figure 43). Ces masses plutoniques 

interprétées dans le SIGEOM correspondent avec la classe 6 (Figure 43 : domaines en rouges). 

Cette classe peut également corresponde aux domaines de haut grade métamorphique (faciès 

amphibolite supérieur à granulite) comme le domaine localisé dans la partie supérieure ouest du 

levé correspondant à des paragneiss à biotite ou des diatexites et/ou métatexites dérivées de 

paragneiss appartenant au Complexe de Rupert ou des roches intrusives tonalitiques à 

granodioritiques à pyroxène et hornblende du Complexe de Champion (ovale bleu ; Figure 43).  

Comme dans l’exemple présenté à la figure 39, le segment de roches volcano-sédimentaires de 

Storm-Evans (Boily et Dion, 2002) ressort bien. Également, les segments d’Evans-Ouagama (Boily 

et Dion, 2002), de Frotet-Troilus (Boily et Dion, 2002), d’Assinica (Boily et Dion, 2002), de Colomb-

Chabouillé, de la rivière Obmasca, de Némiscau et la partie nord de la Sous-province d’Abitibi 

(lignes blanches à la figure 44) ainsi que de nombreux segments de moindres importances et 

répertoriés dans le SIGEOM (Figure 44) ressortent partiellement ou en totalité. Ces domaines 

correspondent aux classes 1 à 5 de la figure 44. Les ceintures de roches volcano-sédimentaires 

sont représentés par les polygones en noirs sur cette figure. Se référer à la figure 4 (page 5) pour 

la localisation et le nom des différents segments de roches volcano-sédimentaires. De plus, les 

domaines associés aux dykes de diabase/gabbro tardifs paléoprotérozoïques sont bien délimités, 

et spécifiquement l’essaim de dykes orientés NE-SO (essaim de dykes de Senneterre). Une fois 

de plus, la classe 2 délimitée par une dizaine de cellules dans le segment de Storm-Evans est 

encore observée (domaines en bruns foncés ; Figure 43). Ces cellules correspondent, selon la 

géologie interprétée provenant du SIGEOM, à des unités stratiformes de formations de fer oxydées 

riches en magnétite, interlitées en quantité variable avec des tufs felsiques ou des basaltes 

appartenant à la Formation de Rabbit. 
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Figure 43: Résultat d’un regroupement/classification obtenu avec le logiciel JMP® par les algorithmes 
hiérarchiques en utilisant l’option 3 (Ward), 4 paramètres et N = 8 classes (Test #25). Remarquez que les 

différents domaines magnétiques sont bien délimités par cette méthode de regroupement/classification. 

 



 
_____________________________________________________________________________
  

_____________________________________________________________________________ 
42 

 

 

Figure 44: Reconnaissance, partielle ou en totalité, des différents segments de ceintures de roches volcano-

sédimentaires (classes 1 à 5, test #25) sur la zone d’étude. Les différents segments de ceintures de roches 
volcano-sédimentaires sont délimités par les polygones blancs. 

 

3.5.4 Synthèse 

Il existe des centaines d’algorithmes de regroupement et de classification. Dans le cadre de ce 

projet, naturellement, il n’a pas été possible de tous les tester. Seulement deux algorithmes ont été 

testés et de manière partielle. Par contre, il est clair que ces deux algorithmes fonctionnent 

relativement bien pour délimiter les différents domaines magnétiques de la zone d’étude à partir 

de la classification des cellules effectuées par les différentes méthodes décrites précédemment (p. 

ex. reconnaissance des ceintures de roches volcano-sédimentaires, reconnaissance de certains 

types de plutons, reconnaissance de faciès métamorphiques de hauts grades, etc.). Il demeure 

encore beaucoup de travail à faire, mais l’utilisation des algorithmes de regroupement et de 

classification s’avère une avenue prometteuse pour l’interprétation et la classification des 

domaines magnétiques de manière semi-automatique. 
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4 DISCUSSION  

Le projet 2017-01 a permis de développer une méthodologie novatrice pour l’analyse des données 

et l’interprétation géologique des levés magnétométriques, et spécifiquement, des levés 

aéromagnétiques. La méthodologie développée permet, de manière semi-automatique, de 

délimiter des domaines magnétiques par les techniques de segmentation d’images fondées sur la 

classification. Ces techniques qui sont utilisées dans de nombreux domaines ont été testées sur 

des levés magnétométriques pour ce projet. Plusieurs paramètres ont été assignés aux cellules à 

partir : 1) de l’analyse spectrale 2) de l’analyse texturale 3) de l’analyse statistique et 4) de l’analyse 

des crêtes magnétiques. Le spectre d’énergie calculé décrit intégralement les caractéristiques de 

l’intensité du champ magnétique de chacune des cellules (c.-à-d. l’orientation, la largeur ou la 

profondeur, l’intensité, la dimension/longueur des anomalies magnétiques). Cette approche élimine 

les artefacts ou l’effet de la variabilité liée au processus d’interpolation classique effectué sur les 

levés (p. ex. Transformées de Fourier). La méthodologie élimine les biais de l’observateur lors 

d’une interprétation manuelle d’un levé magnétométrique (p. ex projet CONSOREM 2016-01 ; 

Lavoie, 2017). 

Par contre, la qualité du résultat final dépend largement de la qualité du processus de segmentation 

et du résultat segmenté (c.-à-d. de la technique de segmentation qui sera choisie). Des centaines 

de techniques de segmentation existent dans la littérature, mais il n’y a pas de méthode unique qui 

peut être considérée comme excellente pour toutes les images, pas plus que toutes les méthodes 

ne sont également bonnes pour une image en particulier (Pal et Pal, 1993). Selon Pavlidis (1977), 

la segmentation d’image est une problématique de perception psychophysique, et donc, qui n’a 

pas une solution unique pure. La sélection d’une technique de segmentation appropriée dépend 

largement du type d’image et des secteurs d’application de ces techniques. C’est pourquoi il est 

important de choisir la bonne technique pour obtenir le meilleur résultat. Dans le cadre de ce projet, 

la technique de segmentation utilisée représente une parmi une multitude de méthodes possibles 

qui n’ont pu être testées. 

La méthode devra être optimisée en prenant en compte les éléments suivants : 

i) Raffinement et hiérarchisation des critères de caractérisation (effectuer une analyse en 

composante principale sur les paramètres);  

ii) Utilisation optimale de l’analyse texturale; 

iii) Discrétisation optimale des cellules selon le levé utilisé; 

iv) Tests avec des cellules en chevauchement et/ou des cellules mobiles;  

v) Optimisation de la méthode en effectuant différents tests avec plusieurs techniques de 

segmentation d’images; 

vi) Test de sensibilité sur les différentes techniques de segmentation d’images; 

vii) Test sur des levés magnétométriques de très haute résolution (drone) à l’échelle de la 

propriété; 
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Plusieurs problématiques n’ont pas été abordées dans ce projet. Une de celles-ci est l’évaluation 

objective des résultats de segmentation. Selon Pal et Pal (1993), il demeure que l’humain est le 

meilleur juge pour évaluer le résultat de n’importe quel algorithme de segmentation. Certains 

indices de validation ont été développés dans la littérature. Il serait intéressant de valider nos 

résultats de segmentation d’images avec ces indices. Une autre question demeure en suspens et 

c’est la possibilité de la surpondération de certains paramètres (p. ex. l’intensité magnétique). C’est 

pourquoi les auteurs recommandent fortement la poursuite du projet dans une phase II pour 

répondre à ces questions. Ultimement, le développement d’un logiciel devrait permettre la 

segmentation de manière automatique et interactive en différents domaines magnétiques, ce qui 

fournirait à l’industrie un outil utile pour l’exploration minérale. 
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5 CONCLUSIONS 

Les résultats obtenus dans le cadre du projet 2017-01 ont démontré qu’il est possible de traiter de 

manière semi-automatique un levé magnétométrique afin de produire une interprétation pseudo-

géologique à partir des domaines magnétiques. La nouvelle méthodologie développée permet 

l’interprétation des levés magnétométriques de haute résolution par des techniques de 

segmentation d’images basée, entre autres, sur l’énergie spectrale du champ magnétique. De plus, 

le projet a permis de développer une méthodologie pour la reconnaissance et la vectorisation des 

crêtes magnétiques. 
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LIVRABLES 

En plus du présent rapport, des quatre (4) présentations PowerPoint livrées lors des réunions du 

comité de gestion scientifique (CGS) et d’une revue de la littérature, plusieurs autres livrables sont 

inclus avec ce projet. Premièrement, une base de données sous forme GDB, Access et Shapefile 

est livrée. Cette base de données comprend la matrice de 9 936 cellules, les points d’intensité 

magnétique anomaliques ayant servi à la création de la couche vectorielle des crêtes magnétiques 

ainsi que la version brute de cette dernière couche (sans élimination des crêtes magnétiques plus 

petites que 752 mètres). Deuxièmement, les données de l’intensité magnétique interpolées des 

levés aéroportés ayant caractérisé les cellules sont également remises sous forme matricielle 

(.GRD). Troisièmement, les données brutes de la caractérisation des cellules calculées au moyen 

de la Discrete Cosine Transform (DCT) sous forme ASCII (.TXT). Finalement, le code MATLABTM 

élaboré pour calculer le spectre d’énergie (analyse spectrale), les textures (analyse texturale) et 

les statistiques classiques de l’intensité magnétique pour chaque cellule.  
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ANNEXES 

Annexe 1 – Liste des feuillets SNRC 1:50 000 couvrant la zone d’étude 2017-01. 

ID_SNRC 
SNRC ID_SNRC SNRC ID_SNRC SNRC 

APREGENT175286 22M13 ISSTSD6204 32J14 ISSTSD6273 32N7 

APREGENT175289 22M14 ISSTSD6203 32J15 ISSTSD6268 32N8 

APREGENT175292 22M15 ISSTSD6202 32J16 ISSTSD6223 32O1 

APREGENT175317 23C10 ISSTSD6206 32J4 ISSTSD6214 32O10 

APREGENT175320 23C11 ISSTSD6209 32J5 ISSTSD6217 32O11 

APREGENT175323 23C12 ISSTSD6212 32J6 ISSTSD6220 32O12 

APREGENT175322 23C13 ISSTSD6211 32J7 ISSTSD6229 32O15 

APREGENT175321 23C14 ISSTSD6210 32J8 ISSTSD6240 32O16 

APREGENT175238 23C15 ISSTSD6205 32J9 ISSTSD6222 32O2 

APREGENT175155 23C16 ISSTSD6161 32K1 ISSTSD6225 32O3 

APREGENT175330 23C5 ISSTSD6152 32K10 ISSTSD6228 32O4 

APREGENT175154 23D1 ISSTSD6151 32K11 ISSTSD6227 32O5 

APREGENT175145 23D10 ISSTSD6154 32K12 ISSTSD6226 32O6 

APREGENT175148 23D11 ISSTSD6157 32K13 ISSTSD6221 32O7 

APREGENT175151 23D12 ISSTSD6156 32K14 ISSTSD6216 32O8 

APREGENT175150 23D13 ISSTSD6155 32K15 ISSTSD6215 32O9 

APREGENT175149 23D14 ISSTSD6166 32K16 ISSTSD6230 32P10 

APREGENT175160 23D15 ISSTSD6160 32K2 ISSTSD6233 32P11 

APREGENT175171 23D16 ISSTSD6159 32K3 ISSTSD6236 32P12 

APREGENT175153 23D2 ISSTSD6162 32K4 ISSTSD6235 32P13 

APREGENT175156 23D3 ISSTSD6165 32K5 ISSTSD6234 32P14 

APREGENT175159 23D4 ISSTSD6164 32K6 ISSTSD6067 32P15 

APREGENT175158 23D5 ISSTSD6163 32K7 ISSTSD6066 32P16 

APREGENT175157 23D6 ISSTSD6158 32K8 ISSTSD6238 32P2 

APREGENT175152 23D7 ISSTSD6153 32K9 ISSTSD6241 32P3 

APREGENT175147 23D8 ISSTSD6177 32L1 ISSTSD6244 32P4 

APREGENT175146 23D9 ISSTSD6168 32L10 ISSTSD6243 32P5 

APREGENT175125 23F2 ISSTSD6171 32L15 ISSTSD6242 32P6 

ISSTSD5887 32F13 ISSTSD6213 32L16 ISSTSD6237 32P7 

ISSTSD5886 32F14 ISSTSD6175 32L3 ISSTSD6231 32P9 

ISSTSD5889 32F15 ISSTSD6180 32L6 ISSTSD6065 33A1 

ISSTSD6182 32I12 ISSTSD6179 32L7 ISSTSD6060 33A10 

ISSTSD6185 32I13 ISSTSD6174 32L8 ISSTSD6068 33A2 

ISSTSD6188 32I14 ISSTSD6169 32L9 ISSTSD6071 33A3 

ISSTSD6193 32I5 ISSTSD6254 32M2 ISSTSD6070 33A4 
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ISSTSD6200 32J10 ISSTSD6253 32M3 ISSTSD6059 33A7 

ID_SNRC SNRC ID_SNRC SNRC ID_SNRC SNRC 

ISSTSD6199 32J11 ISSTSD6270 32N2 ISSTSD6058 33A8 

ISSTSD6198 32J12 ISSTSD6269 32N3 ISSTSD6057 33A9 

ISSTSD6201 32J13     
 

SNRC 1:50 000 NOM FEUILLET SNRC 250 000 

032F13 MATAGAMI 032F 

032F14 LAC OLGA 032F 

032F15 LAC AU GOELAND 032F 

032F16 LAC CAPISISIT 032F 

032G13 LAC INCONNU 032G 

032G14 LAC DES ORIGNAUX 032G 

032G15 CHAPAIS 032G 

032J02 LAC CLAIRE 032J 

032J03 LAC A L'EAU NOIRE 032J 

032J04 LAC OMO 032J 

032J05 LAC CAPICHIGAMAU 032J 

032J06 LAC COMENCHO 032J 

032J07 LAC OPATACA 032J 

032J10 LAC REGNAULT 032J 

032J11 LAC ASSINICA 032J 

032J12 RUIS LUCKY STRIKE 032J 

032J13 LAC GINGUET 032J 

032J14 RIVIERE COIGNE 032J 

032J15 LAC TROILUS 032J 

032K01 LAC YAPUOUICHI 032K 

032K02 LAC PONCHEVILLE 032K 

032K03 LAC SOSCUMICA 032K 

032K04 LAC BOUCHIER 032K 

032K05 LAC MAURICE 032K 

032K06 LAC CHABINOCHE 032K 

032K07 LAC OPATAOUAGA 032K 

032K08 LAC AMISQUIOUMISCA 032K 

032K09 LAC ROCHER 032K 

032K10 LAC SALAMANDRE 032K 

032K11 LAC OUAGAMA 032K 

032K12 CHUTE AUX IROQUOIS 032K 

032K13 LAC RODAYER 032K 

032K14 LAC DANA 032K 

032K15 LAKE EVANS 032K 

032K16 LAC THEODAT 032K 

032L01 LAC PAUL-SAUVE 032L 

032L02 RIVIERE ROUGET 032L 

032L03 LAC SPRADBROW 032L 

032L06 LAC GETTE 032L 
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SNRC 1:50 000 NOM FEUILLET SNRC 250 000 

032L07 RIVIERE DES AULNES 032L 

032L08 LAC OBAMSCA 032L 

032L09 LAC SUZANNE 032L 

032L10 R MISSISICABI OUEST 032L 

032L11 RIVIERE MALOUIN 032L 

032L14 LAC SALOMON 032L 

032L15 RIVIERE PATRICK 032L 

032L16 LAC DUSAUX 032L 

032M01 R NATOUACAMISIE 032M 

032M02 ILE D'HERBOMEZ 032M 

032M03 RIVIERE ISCOUISTIC 032M 

032M04 FRANCIS ISLAND 032M 

032M05 PETITE R MISSISICABI 032M 

032M06 RIVIERE OCTAVE 032M 

032M07 FORT-RUPERT 032M 

032M08 COLLINE JARAY 032M 

032N01 LAC LEGOFF 032N 

032N02 LAC GIFFARD 032N 

032N03 RIVIERE OUASOUAGAMI 032N 

032N04 LAC COLOMB 032N 

032N05 RUISSEAU GAULIER 032N 

032N06 LAC MEZIERES 032N 

032N07 LAC NEMISCAU 032N 

032N08 LAC DE LA SICOTIERE 032N 

032O02 LAC MONTMORT 032O 

032O03 LAC VILLON 032O 

032O04 LAC WEAKWATEN 032O 

032O05 LAC BECHARD 032O 

032O06 LAC MESGOUEZ 032O 

032O07 LAC LA BARDELIERE 032O 

32E12 LAC RAYMOND 032E 

32E15 RIVIERE TURGEON 032E 

32E16 COLLINES GAUDET 032E 

32E17 LAC GRASSET 032E 
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Annexe 2 – Liste des 40 paramètres calculés pour la caractérisation des cellules de 2,5 x 2,5 

km. 

 
Volet Technique Coefficients

Basses_frequences

Moyennes_frequences

Hautes_frequences

Frequences_NS

Frequences_EW

Global_Variance

GLCM_Energy

GLCM_Contrast

GLCM_Entropy

GLCM_Homogeneity

GLCM_SumAverage

GLCM_Variance

GLCM_Dissimilarity

GLCM_AutoCorrelation

GLRLM_SRE

GLRLM_LRE

GLRLM_GLN

GLRLM_RLN

GLRLM_RP

GLRLM_LGRE

GLRLM_HGRE

GLRLM_SRLGE

GLRLM_SRHGE

GLRLM_LRLGE

GLRLM_LRHGE

GLRLM_GLV

GLRLM_RLV

NGTDM_Coarseness

NGTDM_Complexity

NGTDM_Strength

COUNT

Min_nT

Max_nT

Sum_nT

Range_nT

Mean_nT

STD_nT

Densite_CreteMag

EcartType_OrientationMoy

Orientation_Moy_CreteMag
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